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Legal Information
© 1994-2009 Sonic Solutions. All rights reserved. Use of this product is subject to your agreement 
to all of the terms of each of the license agreements included in this package. This product may be 
protected by one or more of the patents listed at www.roxio.com/en/ patents.

Trademarks
Roxio, the burning disc logo, Sonic, Sonic Solutions, Toast, the toaster with discs logo, 
CD Spin Doctor, Fit-to-DVD, Jam, and Toast It are registered trademarks owned by 
Sonic Solutions in the United States, and other jurisdictions.

Third-Party Trademarks and Technologies
Mac, the Mac logo, QuickTime, iLife, iPod, iTunes, iMovie, iPhoto, iPhone, iDVD, DVD Studio 
Pro, Final Cut, and Apple TV are trademarks of Apple, Inc. registered in the U.S. and other 
countries.

PowerPC is a registered trademark of International Business Machines Corporation.

Audio effect engine licensed by Algorithmix, www.algorithmix.com.

VST is a trademark of Steinberg Media Technologies GmbH.

CD and music-related data from Gracenote, Inc., copyright © 2000-2008 Gracenote. Gracenote 
Software, copyright © 2000-2008 Gracenote. One or more patents owned by Gracenote apply to 
this product and service. See the Gracenote website for a non-exhaustive list of applicable 
Gracenote patents. Gracenote, CDDB, MusicID, the Gracenote logo and logotype, and the 
“Powered by Gracenote” logo are either registered trademarks or trademarks of Gracenote in the 
United States and/or other countries.

Music recognition technology and related data are provided by Gracenote®. Gracenote is the 
industry standard in music recognition technology and related content delivery. For more 
information, please visit www.gracenote.com.
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Changes
The material in this document is for information only and is subject to change without notice. 
While reasonable efforts have been made in the preparation of this document to assure its 
accuracy, Sonic Solutions assumes no liability resulting from errors or omissions in this 
document, or from the use of the information contained herein.

Sonic Solutions reserves the right to make changes in the product design without reservation and 
without notification to its users. 

Disclaimer
THIS PRODUCT DOES NOT BYPASS OR CIRCUMVENT COPY PROTECTION. THIS 
PRODUCT DOES NOT ENABLE YOU TO COPY DVDS CONTAINING CSS-ENCRYPTION 
OR OTHER COPY-PROTECTED CONTENT. IF THIS PRODUCT ALLOWS YOU TO COPY 
ANY CONTENT, YOU MAY DO SO ONLY IF YOU OWN THE COPYRIGHT, YOU HAVE 
OBTAINED PERMISSION TO COPY FROM THE COPYRIGHT OWNER, OR YOU HAVE 
THE LEGAL RIGHT TO MAKE SUCH A COPY. IF YOU ARE NOT THE COPYRIGHT 
OWNER OR YOU HAVE NOT OBTAINED PERMISSION TO COPY FROM THE COPYRIGHT 
OWNER, YOU MAY BE VIOLATING COPYRIGHT AND OTHER LAWS LAW AND YOU MAY 
BE SUBJECT TO CLAIMS FOR DAMAGES AND/OR CRIMINAL PENALTIES. ANY ILLEGAL 
USE OF THIS PRODUCT IS STRICTLY PROHIBITED. IF YOU ARE UNCERTAIN ABOUT 
YOUR RIGHTS, YOU SHOULD CONTACT YOUR LEGAL ADVISOR. YOU ASSUME FULL 
RESPONSIBILITY FOR THE LEGAL AND RESPONSIBLE USE OF THIS PRODUCT.
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What is CD Spin Doctor?
If your computer can “hear” it, you can record it with CD Spin Doctor.

Use CD Spin Doctor to:
■ Record streaming audio from the Internet. If you like streaming radio, 

you’ll love Auto Music Capture, which automatically records songs, 
collects artist and album information, and transfers everything into 
your iTunes music library.

■ Digitally restore and preserve LPs and audio tapes.

■ Capture audio over your Mac’s internal microphone or any 
microphone connected to your computer.

■ Split an existing audio file into shorter clips.

■ Clean up and brighten recordings with easy-to-use audio filters.

See also:
• Connecting audio equipment to your Mac on page 9

• Recording audio from an LP or tape player on page 20
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Connecting audio equipment to your Mac
Typically, the first step in importing audio is connecting your audio device 
to your computer. The connection method depends on the type of device 
and the type of Mac you are using. Apple has posted an overview on this 
subject on its Website titled Mac 101: Audio attachments.

Connecting an LP or tape player
The illustration below shows an example of how you might connect a Mac 
to your home stereo to capture recordings from a LP or tape player. The 
socket outlined in red is called an audio input port.

Connection tips:
■ If your Mac does not have an audio input port, you will need to 

purchase an adapter that connects the RCA audio cable from your 
stereo to a USB port on your Mac.

■ Connect your turntable to a stereo or preamplifier, and connect the 
stereo or preamplifier to your Mac. Connecting a record turntable 
directly to your Mac will produce an unsatisfactory results, in most 
cases.
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Connecting an external microphone
Some external microphones can be connected directly to your Mac and will 
work without any further setup. Others require adapters, or adapters with 
preamplifiers. Consult the documentation provided with your Mac and 
your microphone if you are having trouble connecting your equipment.

Connection tips:
■ Microphones with USB connectors are designed to plug directly into 

your Mac’s USB port and are powered by your computer. These 
microphones are a good choice if your Mac does not have an audio 
input port.

■ Microphones typically produce a weak signal and require a preamp to 
boost the signal going into the Mac.

See also:
• Recording audio from an LP or tape player on page 20

• Sending your recordings to iTunes or Toast on page 44
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Adding Auto Capture support
To capture system audio, CD Spin Doctor installs software that allows it to 
save the same audio that you hear through your speakers. The software is 
installed automatically the first time CD Spin Doctor is opened.

If Auto Music Capture is not working as expected, it may be necessary to 
reinstall the software. This normally takes a just few seconds, although you 
may need to restart your Mac after the installation.

To add support for Auto Music Capture:
1 From the CD Spin Doctor menu, choose Install Audio Capture 

Support.

An installation assistant opens. 

2 Follow the on-screen instructions.

See also:
• Recording streaming audio from the Internet on page 22

• Auto Music Capture on page 18

Supported audio formats
CD Spin Doctor can:

■ Open and edit existing audio files.

■ Save audio in the following formats: AIFF, WAV, and MPEG-4 (AAC 
and Apple Lossless).
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Preferences
Customize CD Spin Doctor using the Preferences window. Open it by 
choosing CD Spin Doctor > Preferences. Click one of the buttons at the 
top of the window to access the corresponding preference settings. Use the 
Reset button to restore all preferences to their original factory settings.

The following preference settings are available:

Recording & Playback
■ Recording Starts in Assistant Mode: CD Spin Doctor offers two 

ways to set up your recording projects: a step-by-step Assistant Mode; 
and Advanced Mode, where all project settings are available in a single 
window. To start projects in Advanced Mode, clear this checkbox.

■ Space bar toggles between record and pause: Separate preference 
settings are available for both recording and playback.

■ Recording scratch file location: The scratch file location is where 
recordings are stored while they are being created. Choose a drive 
location with plenty of available space.
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Appearance
■ On application startup: Customize how the application opens. The 

most convenient choice is typically Show the New Project dialog.

■ Always show Auto Music Capture in menu bar: Select this option 
to display a small CD Spin Doctor icon in the menu bar, even when 
you quit the program. Click on the icon to easily launch 
CD Spin Doctor or start Auto Music Capture. The icon also informs 
you when Auto Music Capture is active.

Waveform and Tracks
■ Click and drag in waveform:

■ Allows tracks to be dragged and dropped: When this option is 

selected, tracks can be dragged from the timeline or the track list 

directly into a folder, where they will be saved as an .aif file.

■ Move tracks right and left: When this option is selected, you 

will be able to drag tracks along the timeline without affecting 

their start or end points.

■ Limit zoom range to improve performance: This preference 
changes the maximum waveform magnification available using the 
Zoom slider. Clear this checkbox when you need to make fine manual 
adjustments to your tracks. At other times, you can improve the 
performance of CD Spin Doctor by leaving the checkbox selected.

■ Scroll waveform automatically during playback: When this option 
is selected, the waveform scrolls during playback so the portion of the 
track you hear is always displayed.



Roxio CD Spin Doctor User Guide
www.roxio.com14
Auto Define
Auto Define splits your recordings into separate tracks by looking for 
periods of silence within a recording. But, of course, not all pauses in a 
recording signal the beginning of the next song. Use the controls on this 
panel to improve the results of Auto Define.

■ Standard/analog or Sensitive/digital: Use Standard/analog for 
recordings made from LPs and tapes; Use Sensitive/digital for 
recordings captured from the Internet or other digital sources.

■ Sensitivity: If Auto Define is creating too many tracks, move this 
slider to the left.

■ Minimum Track Duration: No tracks will be created that are shorter 
than the time period set here.

■ Minimum Length of Silence: Auto Define will ignore any pauses 
shorter than the period set here. (One second equals 1,000 
milliseconds. The standard gap between songs on a commercial audio 
tape or LP is 2 seconds.)

Audio Capture
■ Send to ITunes in Format: Auto Music Capture automatically sends 

the tracks it captures to your iTunes music library. Use this drop-down 
list to select the format for files sent to iTunes.

■ Stop Auto Music Capture After: There’s no need to sit by your 
computer waiting for a recording to finish. Use this setting to stop 
Auto Music Capture after a specified period of time. The drop-down 
list includes settings for minutes, hours, or days.
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Keyboard shortcuts
The table below lists useful shortcuts for moving and manipulating tracks:

Shortcut What it does

Ctrl-Left Arrow Moves selected tracks left by 1 second.

Ctrl-Option-Left 
Arrow

Moves selected tracks left by 1/100th of a 
second.

Ctrl-Right Arrow Moves selected tracks right by one second.

Ctrl-Option-Right 
Arrow

Moves selected tracks left by 1/100th of a 
second.

Ctrl-[ Lengthens the track by moving its start time 
one second to the left.

Ctrl-Shift-[ Shortens the track by moving its start time 
one second to the right.

Ctrl-Option-[ Lengthens the track by moving its start time 
1/100th of a second to the left.

Ctrl-Shift-Option-{ Shortens the track by moving its start time 1/
100th of a second to the right.

Ctrl-] Lengthens the track by moving its end time 
one second to the right.

Ctrl-Shift-] Shortens the track by moving its end time 
one second to the left.

Ctrl-Option-] Lengthens the track by moving its end time 
1/100th of a second to the right.

Ctrl-Shift-Option-] Shortens the track by moving its end time 1/
100th of a second to the left.



17
Recording audio
In this chapter

Auto Music Capture 18

Recording audio from an LP or tape player 20

Recording streaming audio from the Internet 22

Recording audio from a microphone 24

Advanced Mode 26



Roxio CD Spin Doctor User Guide
www.roxio.com18
Auto Music Capture
Auto Music Capture automatically records streaming music and sends it to 
your iTunes music library. You can use it to capture songs from your 
favorite Internet radio station or music Web site.

When your recording is complete, Auto Music Capture splits the session 
into tracks, attempts to identify and tag the tracks with song titles, artist 
names, and other information, and sends the songs to iTunes.

Note  To successfully divide a recording into tracks, Auto Music 
Capture requires a period of silence between songs. To record 
songs from an Internet radio station that plays songs 
continuously or has a disc jockey who talks between songs, use 
the steps described in Recording streaming audio from the Internet 
on page 22.

To record audio using Auto Music Capture:

1 Cue up the audio you wish to record.

2 Open CD Spin Doctor by double-clicking its icon in the Finder.

3 Optional: Review your Auto Define and Auto Capture preference 
settings by clicking the CD Spin Doctor menu and selecting 
Preferences. 

Click here to start 
Auto Music Capture
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Settings are available to select the file format of your tracks and to 
control project sensitivity. There’s also a setting that will automatically 
turn off Auto Music Capture after a set period of time. See Preferences 
on page 12 to learn more.

4 Click Start Auto Music Capture . The button name changes 

to Stop Auto Music Capture.

5 When you have finished recording, click Stop Auto Music Capture.

If your computer is connected to the Internet, CD Spin Doctor will 
compare your recordings against those in online music database. If a 
match is found, the song title, artist name, and other information will 
be included with the track when it is sent to your iTunes music library 
and added to the CD Spin Doctor playlist.

Note  A small software component needed to enable Auto Music 
Capture is automatically installed the first time CD Spin Doctor 
is opened. See Adding Auto Capture support on page 11 for more 
information.
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Recording audio from an LP or tape player
CD Spin Doctor includes an easy-to-follow Recording Assistant to help you 
import audio from almost any type of audio equipment.

To import audio from an audio device:

1 Connect the device to your computer. See Connecting audio equipment 
to your Mac on page 9 to learn more.

2 Turn on your device and insert the tape, LP, or other media you want 
to import. Use the controls on your device to cue the media to the 
desired position.

3 Open CD Spin Doctor by double-clicking its icon in the Finder.

4 Click Start a new recording . 

The Recording Assistant opens.

5 Follow the step-by-step instructions in each assistant window.

Click here to start a 
new recording



Recording audio
Recording audio from an LP or tape player 21
6 When you reach the Select an Audio Input Device window, select the 
device that uses Line In as the source. When you reach the Record 
window, start your audio device, then use the Record, Pause and 
Stop buttons on CD Spin Doctor to begin and end your recording. 
(The Record button becomes the Pause button after it is pressed.)

7 When you are finished, click OK.

Tip:  As you become more familiar with CD Spin Doctor, you may 
wish to set up your projects using Advanced Mode, where all settings 
are available in a single window. Click the Advanced button in any of 
the assistant windows to switch to Advanced Mode. See Advanced 
Mode on page 26 for more information.

8 Your recording is displayed as a waveform in the CD Spin Doctor 
project window. Here you can split the recording into tracks, enhance 
the sound by applying filters, add tags to better identify your tracks, 
and send your recording to iTunes or Toast. Click one of the links 
below to learn more:

■ Using the waveform display on page 34

■ Splitting recordings into tracks on page 31

■ Editing tracks on page 35

■ Enhancing your recordings with filters on page 38

■ Adding track information on page 40

■ Sending recordings to Toast on page 44

■ Sending recordings to iTunes on page 44

9 Click File > Save to save your audio file. See Saving recordings and 
tracks as audio files on page 46 to learn more.

Record

Stop

Pause
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Recording streaming audio from the 
Internet
CD Spin Doctor is the perfect tool for capturing audio streamed to your 
computer over the Internet. This topic describes how to do this using the 
Recording Assistant and the CD Spin Doctor project window. You can also 
do this in a more automated way using Auto Music Capture. See Auto Music 
Capture on page 18 to learn more.

To record streaming audio from the Internet:

1 Navigate to the Web site featuring the audio you wish to record.

2 Open CD Spin Doctor by double-clicking its icon in the Finder.

3 Click Start a new recording . 

The Recording Assistant opens.

4 Follow the step-by-step instructions in each assistant window.

5 When you reach the Select an Audio Input Device window, select 
CDSD System Audio Capture from the device list.

Click here to start a 
new recording
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6 When you reach the Record window, start the Internet audio stream, 
then use the Record, Pause and Stop buttons on CD Spin Doctor to 
begin and end your recording. (The Record button becomes the Pause 
button after it is pressed.)

7 When you are finished, click OK.

Tip:  As you become more familiar with CD Spin Doctor, you may 
wish to set up your projects using Advanced Mode, where all settings 
are available in a single window. Click the Advanced button in any of 
the assistant windows to switch to Advanced Mode. See Advanced 
Mode on page 26 for more information.

8 Your recording is displayed as a waveform in the CD Spin Doctor 
project window. Here you can split the recording into tracks, enhance 
the sound by applying filters, add tags to better identify your tracks, 
and send your recording to iTunes or Toast. Click one of the links 
below to learn more:

■ Using the waveform display on page 34

■ Splitting recordings into tracks on page 31

■ Editing tracks on page 35

■ Enhancing your recordings with filters on page 38

■ Adding track information on page 40

■ Sending recordings to Toast on page 44

■ Sending recordings to iTunes on page 44

9 Click File > Save to save your project. See Saving recordings and tracks 
as audio files on page 46 to learn more.

Record

Stop

Pause
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Recording audio from a microphone
CD Spin Doctor can record audio from your Mac’s internal microphone or 
any microphone connected to your computer.

To record audio from a microphone:

1 If you are using an external microphone, connect it to your computer 
and turn it on. See Connecting audio equipment to your Mac on page 9 
for more information.

2 Open CD Spin Doctor.

3 Click Start a new recording . 

The Recording Assistant opens.

4 Follow the step-by-step instructions in each assistant window.

5 When you reach the Select an Audio Input Device window, select the 
device that uses Internal Microphone from the device list, if you are 
using your Mac’s internal microphone. Select Line In if you are using 
an external microphone.

6 When you reach the Record window, use the Record, Pause and Stop 
buttons on CD Spin Doctor to begin and end your recording. (The 
Record button becomes the Pause button after it is pressed.)

7 When you are finished, click OK.

Tip:  As you become more familiar with CD Spin Doctor, you may 
wish to set up your projects using Advanced Mode, where all settings 
are available in a single window. Click the Advanced button in any of 
the assistant windows to switch to Advanced Mode. See Advanced 
Mode on page 26 to learn more.

Record

Stop

Pause
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8 Your recording is displayed as a waveform in the CD Spin Doctor 
project window. 

Here you can split the recording into tracks, enhance the sound by 
applying filters, add tags to better identify your tracks, and send your 
recording to iTunes or Toast. Click one of the links below to learn 
more:

■ Using the waveform display on page 34

■ Splitting recordings into tracks on page 31

■ Editing tracks on page 35

■ Enhancing your recordings with filters on page 38

■ Adding track information on page 40

■ Sending recordings to Toast on page 44

■ Sending recordings to iTunes on page 44

9 Click File > Save to save your project. See Saving recordings and tracks 
as audio files on page 46 to learn more.
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Advanced Mode
CD Spin Doctor offers two ways to set up your recording projects: a step-
by-step Assistant Mode and Advanced Mode, where all project settings are 
available in a single window. You can select the mode your prefer by 
choosing CD Spin Doctor > Preferences and selecting or clearing the 
Recording starts in Assistant Mode checkbox.

Tip:  While working with the Recording Assistant, you can switch to 
Advanced Mode by clicking the Advanced button.
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The following settings are available on the Advanced Mode window:

General Settings
■ Record/Stop/Pause controls.

■ Automatically stop recording after: Select a time from the drop-
down list.

■ Play Input through speakers: Select this option to hear what you are 
recording.

Input Settings
■ Input Device

■ Built-in Microphone: Choose this option if you are recording 

with your Mac’s built-in microphone.

■ Built-in Input: Choose this option if you are recording from an 

audio device connected to your computer.

■ CDSD System Audio Capture: Choose this option if you are 

recording audio from the Internet or from an internal source 

such as your computer’s CD or DVD player.
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Input source:

■ Input Volume: Use the slider to manually adjust the volume, or click 
Auto-Level to have CD Spin Doctor do it for you. When setting the 
volume manually, watch the level indicators. Lower the volume if the 
indicators extend into the red zone.

■ Recording Quality — Choose one of the following:

■ CD Quality: This standard 16-bit quality is acceptable for most 

projects.

■ DVD Quality: Use this setting if your audio will be incorporated 

into a DVD-Video project.

■ DVD High Quality: This is a high quality 24-bit setting.

■ Custom Setting: Several are available in 16-bit, 20-bit, and 24-bit 

formats.

Recording Info
This portion of the window provides information to help you monitor 
the size of your projects and the available hard drive space.
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Using the CD Spin Doctor editor
The heart of CD Spin Doctor is the editing window. It opens after you 
create a recording or when you open a saved recording.

Use editing window to:

■ Split your recording into tracks. See Splitting recordings into tracks on 
page 31.

■ Edit tracks. See Editing tracks on page 35 or Using the waveform display 
on page 34.

■ Apply filters to enhance your recording. See Enhancing your recordings 
with filters on page 38.

■ Add song information. See Adding track information on page 40.

■ Export your tracks to iTunes or Toast. See Sending your recordings to 
iTunes or Toast on page 44.

Project 
buttonsPlayback 

controls

Waveform 
display

Info/Filters 
panel

Track List
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Splitting recordings into tracks
It’s often useful to divide recordings into smaller segments or tracks. A track 
might be a single song from a concert, a chapter from an audio book, or a 
key passage from a lecture. CD Spin Doctor can create tracks for you (by 
searching for periods of silence in your recordings), or you can create tracks 
yourself.

Creating tracks automatically
Use Auto Define to have CD Spin Doctor examine your recording and 
create track breaks where periods of silence are detected. You can set 
CD Spin Doctor to use Auto Define with every recording or only when you 
choose. There are also settings that control the feature’s sensitivity. See 
Preferences on page 12 to learn more.

To use Auto Define to create tracks:

1 Create a new recording or open a saved recording.

2 Click Auto Define .

The results appear in the track list.

Tip:  To delete a track, select it in the track list and click CD Spin 

Doctor’s Delete button .

Auto define Delete
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Creating tracks manually
Tracks are created manually using the lower of the two waveform displays. 
Two creation methods are available: click-and-drag and single-click. Use 
the Track Mode buttons to choose the method you prefer.

Click-and-Drag
When Click-and-Drag mode is selected, create a track by clicking outside of 
an existing track on the lower waveform where you want the track to begin. 
Drag to the right, and release the mouse button at the position where you 
want the track to end. Your newly created track is displayed on the timeline 
as a colored rectangle and appears in the track list just below the waveform. 
You can adjust the track’s beginning or ending position by clicking the left 

Click and drag
Single click

Use this timeline to
manually create tracks

Track list
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or right edge of the colored rectangle and dragging. See Editing tracks on 
page 35 to learn more.

Single Click
When Single Click mode is selected, the first track will automatically start at 
the beginning of the recording and end at the point where you click the 
waveform. Click again (but not on an existing track) to set the end point of 
your next track. It will be positioned next to the preceding track.

See also:
• Using the waveform display on page 34

• Keyboard shortcuts on page 15
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Using the waveform display
The waveform display is where you create and edit tracks. The upper 
waveform always shows the entire recording. The lower waveform shows 
your tracks and can be enlarged to show as much detail as you need. 

The display includes an upper and lower timeline, a zoom control, a 
playhead, and a Fit checkbox. When the Fit checkbox is selected, the 
magnification of the lower waveform is adjusted to match the upper 
waveform and the zoom control is disabled.

As you add tracks, they appear on the lower waveform as colored rectangles. 
To play a track, double-click on it in the display.

The illustration below identifies the major features of the waveform display.

The display can be customized using the Waveform & Tracks preferences 
panel. See Preferences on page 12 for more information.

See also:
• Splitting recordings into tracks on page 31

• Editing tracks on page 35

Playhead

Zoom control
Fit checkbox

Timeline

Tracks

The portion of 
the overall 
recording 
displayed in the 
track timeline.
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Editing tracks
Once a track has been added to the timeline, it can be repositioned and 
made shorter or longer. Before you begin, here are a couple of tips:

■ Only Active tracks appear in the timeline. These are tracks that have 
the Active checkbox selected in the Track List. Clear the checkbox for 
all tracks except the track you wish to reposition or resize. Remember 
to restore their active status when you are done.

■ Use the zoom control to display the necessary level of detail in the 
timeline. This will help you precisely edit a track. Maximum zoom is 
only available when the Limit zoom range to improve performance 
setting is cleared on the Preferences dialog. See Preferences on page 12 
to learn more.

To reposition a track on the timeline without changing its length:

1 Click the track in the timeline. Drag the track left or right to the 
desired position. (Depending on your Preference settings, you may 
need to hold down the Option key as you drag.)

To change the length of a track using the timeline:

1 Click on the left edge of a track and drag it left or right to change the 
start position.

2 Click the right edge of the track and drag it left or right to change the 
end position.
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To change the length of a track using the Info panel:

1 Select a track in the timeline or on the track list.

2 Click the Info button  to display the Info panel.

3 Click the Details button at the top of the Info panel.

4 Use the Track Time and Size controls to adjust the track.

See also:
• Adding track information on page 40

• Keyboard shortcuts on page 15
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Playing a track

To play a track:
■ Double-click the track’s colored rectangle in the lower timeline.

or

■ Select the track in the track list and click Play.

Deleting a track

To delete a track:

1 Select the track in the lower timeline or in the track list.

2 Click Delete . 

This only deletes the track definition, not the audio recording.
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Enhancing your recordings with filters
CD Spin Doctor lets you remove noise common to analog audio sources 
such as records and tapes. You can also enhance your audio clip by 
adjusting the equalization or bass, brightening the sound, or applying 
“de-clicking” effects to clean up audio recorded from scratchy vinyl LPs.

To enhance a recording:

1 Capture a recording using the Recording Assistant or Advanced Mode.

2 If desired, create tracks using Auto Define or by manually creating 
tracks on the timeline. See Splitting recordings into tracks on page 31 
for more information.

3 Click the Filters button . 

The Filters panel is displayed. You will see three categories of Filters: 
Noise Reducer, Sound Enhancer, and EQ10. 

4 Click one or more of the category checkboxes to activate the filters in 
that category.

5 Click Play. This way you can hear the changes as each filter is applied.

6 Apply a filter by adjusting its slider.

Filters button

Select a 
checkbox to 
activate that 
group

Move any slider 
left or right to 
adjust the filter
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7 Filters can be applied to an entire recording, to one or more individual 
tracks, or to all active tracks. Make a selection using the Apply To 
drop-down list near the bottom of the Filters panel. (Make tracks 
active or inactive by selecting or clearing the checkboxes in the Track 
List.) 

8 If you wish make a copy of your audio recording before filters are 
applied, select the Create copy before applying checkbox. 

9 Click Apply.
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Adding track information
Track information or tags such as album and artist names, genre, and year, 
can be added by hand and, in some cases, automatically.

If you have an Internet connection, CD Spin Doctor is linked to an online 
music identification service. If the song you have recorded matches one in 
the song database, information about the song will be entered 
automatically.

To add track information automatically:

1 Create a new recording or open a saved recording.

2 Create tracks using one of the methods described in Splitting 
recordings into tracks on page 31.

3 Click Identify.

4 Choose Identify All Tracks.

Your tracks will be matched against an online song database. You will 
be notified if multiple matches are found for a single song.

5 Click Info  and then Tags. Select a track in the Track List to view 
and the tags for that song will be displayed in the Tags panel.

6 For tracks with multiple matches, click identity result on the Tags 
panel to select the correct match.

To add track information manually:

1 Select a track by clicking on it in the track list.

2 Click Info  and then Tags.

Identify
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3 Enter the track information into the spaces provided.

Tip:  Here’s a way to save yourself some work if many of the tracks in a 
recording will have the same tags. Create a track, and make sure it’s 
active. Open the Tags panel and enter the tags your tracks will have in 
common. Click Use as Defaults. The tags you entered will be added 
automatically to each new track you create.

Tags button

Enter track 
information 
here

Identity result

Info
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Sending your recordings to iTunes or Toast
CD Spin Doctor is designed to work seamlessly with both iTunes and Toast 
Titanium, when either program is detected on your Mac. Recordings can be 
easily sent to your iTunes music library or burned to a disc using Toast.

Sending recordings to iTunes
CD Spin Doctor makes it easy to transfer tracks to your iTunes music 
library.

To send tracks to iTunes:

1 Create a new recording, or open a saved recording.

2 If desired, use Auto Define  or the waveform display to create and 
edit tracks. Make sure the tracks you want to send to iTunes are active. 
A track is active if the Active checkbox next to its name is selected in 
the track list.

3 Click the iTunes button .

4 In the dialog box that appears, select a file format from the drop-down 
list.

5 Optional: If you have used Filters to enhance your tracks, the Apply 
Filters to Tracks checkbox will be available. Select it to apply the Filter 
settings to the tracks you are sending to iTunes.

6 Click OK.

The tracks are sent to an iTunes playlist titled CD Spin Doctor.

Sending recordings to Toast
CD Spin Doctor automatically knows if Toast 10 Titanium is installed on 
your computer, which makes it simple to export your files to Toast and 
burn them onto a disc.

Use the Toast menu in CD Spin Doctor to send an entire recording to Toast 
or just the tracks you select. You can choose to have the tracks added to an 
Audio CD project or a Music DVD project.
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Here are some tips when using the Toast menu:

■ Track-specific menu items will be grayed out until individual tracks 
have been created in CD Spin Doctor.

■ If there are no tracks checked as Active in CD Spin Doctor, the menu 
items specific to active tracks will be grayed out.

■ After sending recordings to Toast, the Toast application window may 
be partially hidden behind the CD Spin Doctor application window. 
To bring Toast forward, open the Toast menu in CD Spin Doctor and 
choose Bring Toast to Front.

■ For more information about burning discs, open the Help menu in 
Toast and choose Toast Titanium Help.

See also:
• Auto Music Capture on page 18
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Saving recordings and tracks as audio files
Entire recordings and individual tracks can be saved as audio files.

To save an entire recording as an audio file:

1 Record audio using the Recording Assistant or Advanced Mode. See 
Recording audio on page 17 for more information.

2 Open the CD Spin Doctor editing window. See Using the 
CD Spin Doctor editor on page 30 for more information.

3 Click the File menu and select Save.

4 Select a name, destination, file format and data format.

5 Click Save.

To save tracks as audio files:

1 Record audio using the Recording Assistant or Advanced Mode. See 
Recording audio on page 17 for more information.

2 Open the CD Spin Doctor editing window. See Using the 
CD Spin Doctor editor on page 30 for more information.

3 Create one or more tracks. See Splitting recordings into tracks on 
page 31 for more information.

4 Optional: Add track information and apply audio filters if desired.

Tip:  To exclude a track that you do not wish to save, clear the Active 
checkbox next to the name of the track.

5 Click the File menu and select Save Active Tracks.

6 Select a destination for the files.

7 Click Save.

Note  CD Spin Doctor does not save project files. This means the 
work that you do to create tracks from a recording is not 
preserved when the recording is saved as an audio file.
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